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[bookmark: _Mapping_the_Mail]Mapping the Mail in Frankenstein (1818) with Palladio

For this exercise, we will be using Palladio to visualize a small data set taken from Mary Shelley’s Frankenstein (1818). Palladio is a data visualization tool that requires you to have structured data (such as the below table) prior to use.

	Letters Sent in Frankenstein

	To
	From
	Date Sent*
	
Place 1
	Origination**
	
Place 2
	Destination**

	Mrs. Saville
	R. Walton
	1790-12-11
	St. Petersburgh
	59.9343, 30.3351
	England
	51.5074, 0.1278

	Mrs. Saville
	R. Walton
	1791-03-28
	Archangel
	64.5473, 40.5602
	England
	51.5074, 0.1278

	Mrs. Saville
	R. Walton
	1791-07-07
	Arctic Ocean
	73.124213, 40.133004
	England
	51.5074, 0.1278

	Mrs. Saville
	R. Walton
	1791-08-05
	Arctic Ocean
	75.248382, 40.133004
	England
	51.5074, 0.1278

	Mrs. Saville
	R. Walton
	1791-08-13
	Arctic Ocean
	78.327935, 40.133004
	England
	51.5074, 0.1278

	Mrs. Saville
	R. Walton
	1791-08-19
	Arctic Ocean
	81.278934,  40.133004
	England
	51.5074, 0.1278

	Mrs. Saville
	R. Walton
	1791-08-26
	Arctic Ocean
	82.359203,  40.133004
	England
	51.5074, 0.1278

	Mrs. Saville
	R. Walton
	1791-09-02
	Arctic Ocean
	83.972721, 40.133004
	England
	51.5074, 0.1278

	Mrs. Saville
	R. Walton
	1791-09-05
	Arctic Ocean
	83.972721, 40.133004
	England
	51.5074, 0.1278

	Mrs. Saville
	R. Walton
	1791-09-07
	Arctic Ocean
	83.453277,  40.333004
	England
	51.5074, 0.1278

	Mrs. Saville
	R. Walton
	1791-09-12
	Arctic Ocean
	76.170110,  40.333004
	England
	51.5074, 0.1278

	Victor Frankenstein
	Elizabeth Lavenza
	1790-03-18
	Geneva
	46.2044, 6.1432
	Ingolstadt
	48.7665, 11.4258

	Victor Frankenstein
	Alphonse Frankenstein
	1790-05-12
	Geneva
	46.2044, 6.1432
	Ingolstadt
	48.7665, 11.4258

	Victor Frankenstein
	Elizabeth Lavenza
	1792-05-18
	Geneva
	46.2044, 6.1432
	Ingolstadt
	48.7665, 11.4258

	Elizabeth Lavenza
	Victor Frankenstein
	1792-05-18
	Ingolstadt
	48.7665, 11.4258
	Geneva
	46.2044, 6.1432

	*Mary Shelley did not provide full years in Frankenstein. All year dates appear as 17--. The above dates are placeholders to give a sense of the time line over which letters were sent and received in the novel.

**Many of these coordinates are approximations, as Shelley used countries or cities but not addresses.  



Although the above data set is necessarily incomplete (the sending and receipt of letters are mentioned 49 times in the novel, but not always with specified dates or senders), using digital tools to work with it provides an interesting sense of the scale of letter writing in the novel. 

· Time: 10 minutes

· Tools: Palladio (free digital tool), spreadsheet populated with data (.csv file)

· Takeaways: using tools like Palladio in the Viz Lab to process data you’ve already gathered can help you showcase the strengths of your research, approach your data from a new perspective, and engage others.


To begin:
· Pull up Palladio at the following URL: http://hdlab.stanford.edu/palladio/
· In a separate tab, go to ________________________ and select _____________________
· Copy the spreadsheet
· Back on Palladio, press the “Start” button
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· Paste the spreadsheet into Palladio where indicated 
· Click the “Load” button
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You should see a screen like this: 

[image: ]

· At the top of the page, select “Map” 
· On the right of the page, press the “New layer” button 
[image: ]

· On the resulting menu, select “Point to Point” for “Map type” 
· For “Source Places” select “Origination” 
· For “Target Places” select “Destination” 
· Select whatever color strikes your fancy 
· Check the box for “Size points” 
· Click “Add layer” at the bottom of the menu 
[image: ]

You should see something like this:
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To change the map background:
· Press the “New layer” button again
· Select “Tiles” at the top of the menu
· Choose the “Tiles type” you desire
· Click “Add layer” at the bottom of the menu 
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You should see something like this:
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To view a timeline with your map:
· Select “Timeline” or “Timespan” from the bottom left-hand corner:
[image: ]
· Choose what data displays with the selection tools on the right-hand side of the resulting screen:[image: ]

To share your visualization on the Viz Wall Screen:
· Refer to SAGE2 instructions at the back of this packet

To export your data visualizations: 
· Currently, the only way to do this is to use your device’s screenshot or screengrab feature

To learn about Palladio’s other features:
· http://hdlab.stanford.edu/palladio/help 


USE DIFFERENT COORDINATES TO CHANGE THE SHIP’S DIRECTORY, 

OR TRY WITH ANOTHER DATA SET!
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[bookmark: _Visualizing_Frankenstein_(1818)]Visualizing Frankenstein (1818) with Voyant Tools

For this exercise, we will be using Voyant Tools to analyze the entire text of Frankenstein (and, optionally, a corpus of other nineteenth-century gothic novels). Voyant Tools is a suite of digital tools that allows you to analyze individual texts and corpuses (groups of texts) in a variety of ways. This document will walk you through two different examples. 

· Time: ~10 minutes

· Tools: Voyant Tools, plain text file or text URL

· Takeaways: Text analysis and visualization can reveal patterns in texts or corpuses which clarify research questions you have and generate new questions. In the Viz Lab, these patterns are even clearer because you can see more detail in dense word clouds and other visualizations.

[bookmark: _Option_1:_Frankenstein]Option 1: Frankenstein or Frankenstein’s Monster? 
In this version of the exercise, we will be using Voyant Tools “Cirrus” and “Links” features to analyze the text of the novel in order to answer this question: what term should we use to refer to the monster? Frankenstein? Frankenstein’s monster? Or something else entirely?

1. To begin, go to www.gutenberg.org
2. Search for Frankenstein
3. Select the first result
4. Copy the text of the novel
5. In another window, open https://voyant-tools.org
6. Paste the text of the novel into the box you see there, and click the blue rectangle “Reveal” button
[image: C:\Users\cfloyd3\AppData\Local\Microsoft\Windows\INetCache\Content.Word\Screen Shot 2018-10-22 at 12.40.18 PM.png]





7. You should see a large command screen that looks like this:
[image: C:\Users\cfloyd3\AppData\Local\Microsoft\Windows\INetCache\Content.Word\Screen Shot 2018-10-22 at 12.40.55 PM.png]
8. Locate the “Cirrus” view in the top left, and click the “Export” button (a blue square outline with an arrow pointing to the top right)
9. Click “Export” in the resulting dialog box. This will open a new tab--don’t close the old one, we’ll need it again
10. The resulting word cloud displays the most frequently used terms (with automatic stopwords--words that aren’t included because they’re so common, like “the”)
11. You can adjust how many words you see with the slider at the bottom left
12. If you set the slider to the top 55 words, for example, this is the view you should get:
[image: C:\Users\cfloyd3\AppData\Local\Microsoft\Windows\INetCache\Content.Word\Screen Shot 2018-10-22 at 12.46.39 PM.png]
13.  (Note that neither Frankenstein nor monster appear in the top 55 - increase the selection size until you see them!)
14. The below view, which increased the selection size to 145, still doesn’t include Frankenstein - but it does include “monster” (used 31 times), “creature” (42 times) and fiend (33)
[image: C:\Users\cfloyd3\AppData\Local\Microsoft\Windows\INetCache\Content.Word\Screen Shot 2018-10-22 at 12.52.02 PM.png]
15. Bump it up to 185, and Frankenstein appears (used 27 times in the novel)
[image: C:\Users\cfloyd3\AppData\Local\Microsoft\Windows\INetCache\Content.Word\Screen Shot 2018-10-22 at 12.52.17 PM.png]
16. These results hint at a pattern which we can explore with other Voyant Tools views
17. Go back to the original tab and, in the top left corner again, select the “Links” view
18. Click the “Export” button and repeat step 9
19. Here, we’re going to use the terms we identified with “Cirrus” to see if we can flesh out the pattern we glimpsed in the word clouds by using the search box at the bottom left of the screen to narrow the data we’re seeing a bit 
20. Click the “Clear” button with the trashcan on it (right beside the search box)
21. Type in “monster” and select “monster* (33)” to include all variations of the word
22. Repeat step 21 for “creature,” “fiend,”  “man,” “Victor” (don’t select the asterisked option for this term), and “Frankenstein”
23. You should see these terms appear in blue, linked to terms which commonly appear with them in orange
24. You can drag these terms around to get a clearer view of what is linked to what
[image: C:\Users\cfloyd3\AppData\Local\Microsoft\Windows\INetCache\Content.Word\Screen Shot 2018-10-22 at 1.04.32 PM.png]
25. Here, “Links” indicates that the term “fiend” is used most often when Frankenstein’s creation is connected somehow to his family (his father and wife, specifically), while the term creature (which is used most often of all) is used when Frankenstein’s creation is associated with or experiencing joy and pleasure. The word “monster” is connected almost entirely to the visual realm with the terms “eye” and “saw,” indicating that he is monstrous to behold, but not necessarily a monster outside of the concepts of normalcy and beauty… (the term “Frankenstein” is never used to refer to the creature, but more text analysis could reveal that it is oftener connected to monstrousness--try it for yourself and see!)
26. To save a copy of your visualizations, take a screenshot or screen grab (easiest), or, click the “Export” button, select the “Export View” dropdown, and choose HTML snippet

To share your visualization on the Viz Wall Screen:
· Refer to SAGE2 instructions at the back of this packet

So, next time someone corrects you for calling Frankenstein’s creature Frankenstein (or next time you correct someone else), refer back to this and have a more nuanced discussion!
[bookmark: _Option_2:_Visualizing]Option 2: Visualizing the Gothic
In this exercise, we’ll take a more open-ended approach to a corpus of eighteenth- and nineteenth-century Gothic novels (Frankenstein, Wuthering Heights, Dracula, The Sorrows of Satan, and The Mysteries of Udolpho) to see what patterns we can identify by defining stopwords, and using the “Cirrus,” “StreamGraph,” and “Trends” tools. 

1. Because we’re dealing with a large corpus, I’ve preloaded it into Voyant Tools for you: https://voyant-tools.org/?corpus=5529c2bd927a84ab74adc351973c5bda&panels=corpusterms,reader,contexts,summary,correlations&lang=en
2. Voyant Tools doesn’t like to remember stopwords, so you’ll need to add your own to filter out some of the more common words (like character’s names). To do so, click the above link and when it has loaded, hover over the menu bar near the “Cirrus” tool until you see a little toggle switch and click it
[image: C:\Users\cfloyd3\AppData\Local\Microsoft\Windows\INetCache\Content.Word\toggle image.PNG]
3. In the resulting dialog box, the first item is “Stopwords.” Click the dropdown menu beside it and select “English” from the list. Then, click the “Edit List” button beside the dropdown menu to add custom stopwords. I’d recommend inserting the character’s names here as well as “said” and “like.” One line at a time, enter: Frankenstein, Elizabeth, Clerval, Catherine, Heathcliff, Cathy, Hareton, Nelly, Hindley, Sibyl, Lucio, Rimanez, Lucy, Mina, Jonathan, Harker, Murray, Godalming, Arthur, Jack, Seward, Van Helsing, Justine, Felix, Emily, Morano, Valancourt, St, Aubert, and Dracula
4. Press the “Confirm” button
5. Locate the “Cirrus” view in the top left, and click the “Export” button (a blue square outline with an arrow pointing to the top right)
6. Click “Export” in the resulting dialog box. This will open a new tab--don’t close the old one, we’ll need it again
7. The resulting word cloud displays the most frequently used terms (with automatic stopwords--words that aren’t included because they’re so common, like “the”)
8. You can adjust how many words you see with the slider at the bottom left
9. Go back to the original tab and, hovering over the menu bar in the right corner, select the icon that looks like the Window’s symbol. 
10. In the resulting dropdown menu, select “Visualization Tools,” and in that dropdown menu, select “StreamGraph”
11. Repeat step 6
[image: C:\Users\cfloyd3\AppData\Local\Microsoft\Windows\INetCache\Content.Word\Screen Shot 2018-10-22 at 2.38.57 PM.png]
12. Repeat step 9
13. In the resulting dropdown menu, select “Trends”
14. Repeat step 6
[image: C:\Users\cfloyd3\AppData\Local\Microsoft\Windows\INetCache\Content.Word\Screen Shot 2018-10-22 at 2.39.14 PM.png]
15. Manipulate the data you’re seeing by adding or removing terms
16. Right click on words to remove them from the visualization
17. Use the search menu at the bottom of each visualization to add terms (you might refer to the Cirrus visualization to identify the most commonly appearing terms that you’re interested in adding to the other visualizations)
18. Explore the results – what patterns can you identify based on these visualizations? What questions do these visualizations raise for you about Gothic literature and / or the novels in question?

To share your visualization on the Viz Wall Screen:
· Refer to SAGE2 instructions at the back of this packet





[bookmark: _Visualizing_Frankenstein_(1818)_1]Visualizing Frankenstein (1818) with Sonic Visualiser

For this exercise, you will use sound to visualize Frankenstein. By recording yourself reading a passage from the novel, you will be able to see Mary Shelley’s diction and syntax come to life in images similar to the ones below. Because everyone who participates in this activity will be reading the same passage, we’ll be able to combine all of the recordings into a giant collage which we can use to compare and contrast recording data. 

[image: ][image: ]

· Time: 5-10 minutes

· Tools: Sonic Visualiser (free, open source program), USB microphone 

· Takeaways: The Viz Lab can foster creative, collaborative data visualization that generates questions for future research!

Note:  To simplify the process for this activity, we’ve made a laptop with Sonic Visualiser pre-downloaded available.

To begin, create a sound recording:
· Open Audacity
· Locate the reading prompt on the next page of this packet
· Click the red circle “record” button to begin recording your audio
· Wait 2-3 seconds to capture the room’s ambient noise
· Read the passage on the prompt
· Press the black square “stop” button to end the recording
· Clean up your audio by taking the following steps:
· Click and drag over the 2-3 second portion of the recording at the beginning of the track
· Select the “Effect” menu at the top of the screen
· Select “Noise Reduction” from the resulting dropdown menu
· Click the “Get Noise Profile” button.
· Select your entire recording by clicking on the audio track
· Open the “Effect” menu again
· Select “Noise Reduction” again
· Click “Ok”
· Export your file by selecting “File” from the menu at the top of the page and choosing “Export,” then “Export as WAV”
· Give the file a non-identifying name such as “frankenreads1” or, if that’s taken, “frankenreads2” and so on

To create a visualization of the recording you just made:
· Open Sonic Visualiser
· Click the folder icon in the menu bar to import your sound file
· Before you manipulate the resulting visualization, save the recording via the following steps:
· Select “File” from the menu at the top of the page
· Select “Save Session As” from the resulting dropdown menu
· Please don’t overwrite any previously saved files!!!
· To manipulate the audio visualization:
· To change the color of the linear visualization the program automatically generated, click button 3 on the menu panel on the right side of the screen and select the color you would like from the dropdown list there. 
· To change the scale of the visualization (what’s being charted), use the same menu, but select “Meter” or “dB” in the dropdown list labeled “Scale”
· You can experiment with other visual outputs by selecting the “Layer” menu at the top of the page. (Try “Add Spectrogram” and select “all channels mixed,” for example)
· To see two (or more) different visualizations at once, select the “Pane” menu at the top of the page and choose an option from the resulting dropdown list.
· Please save your visualization by:
· Selecting “File” from the menu at the top of the page
· Selecting “Export Image File” from the resulting dropdown menu
· Saving the image with the same name you gave the recording itself (i.e., “frankenreads1”)
· From here, you can throw your visualization up onto the big screen using the SAGE2 instructions at the back of this packet!

Reading Prompt:
“Are you to be happy while I grovel in the intensity of my wretchedness? You can blast my other passions, but revenge remains—revenge, henceforth dearer than light or food! I may die, but first you, my tyrant and tormentor, shall curse the sun that gazes on your misery. Beware, for I am fearless and therefore powerful.” 
[bookmark: _d0937w50osib]

[bookmark: _Instructions_for_accessing]Instructions for accessing and using SAGE2 in the PSC Visualization Lab

Before Arriving
· Step 1 
[bookmark: _gjdgxs]Download the Google Chrome browser: https://www.google.com/chrome/
(If you already have Chrome installed, then skip to the next step.)
· Step 2
Add the SAGE2 Screen Capture extension to your Chrome browser: https://chrome.google.com/webstore/detail/sage2-screen-capture/mbkfcmpjbkmmdcfocaclghbobhnjfpkk?hl=en 

Accessing SAGE2
· Step 1
Touch the Viz Wall control panel to “wake” the wall
· Step 2
Select “SAGE2” from the menu
· Step 3
On your own device, go to the following URL: https://lib-sage2.uoregon.edu/
· Step 4
Ask the Visualization Lab Specialist for the password of the day


Using SAGE2 on your own device
· Step 1
Click on the cursor button to create a personalized cursor (hit ESC to use another tool!)
· Step 2
Add items to the Viz Wall by using the Media Browser (folder button) or Screen Sharing (screen button) functions

Note: in order to interact with these items on the Viz Wall, you will need to click the cursor button again. To manipulate items from your own laptop or device, hit the escape button (esc) and use your mouse or track pad as you normally would.

· Step 3
You can resize items you’ve placed on the Viz Wall by clicking the box icon in the top right corner of the item, or by hovering over the bottom right corner until a lighter colored square appears and dragging the item larger or smaller using the square
· Step 4
Close items you added to the wall by clicking on the hand icon in the top right corner of the item

Simply close your browser when you are done with your session!
Please close all items on the Viz Wall and delete all added media from the Media Browser 
at the close of your session in the Viz Lab!
[bookmark: _xsapqf60ove2]
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Create a new Palladio project by uploading your data from a spreadsheet or flat-file, or load data from a SPARQL endpoint. Not
sure how Palladio works?
Load .csv or spreadsheet

Copy and paste out of your spreadsheets, drag-and-drop to upload tabular data (g csv. tab, tsv), or link to a file in a public
Dropbox folder to create a new Palladio project. Not sure how to structure your data?

1

More than one table? No problem If you have more than one table, start by uploading your primary table. The primary table should contain
the main entities you want to visualize. It could be a collection of objects, like persons or letters, or more abstract concepts, like relationships
or flows. Once you have uploaded your primary table, you will be able o extend it with additional information from other tables.

Load data from a SPARQL endpoint (beta)
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